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Preamble 

This document offers a glimpse into the significant Service Pack updates in PTV Vistro, 
spanning from version 2023 to version 2024, as well as the latest additions in the initial 
release of version 2024. For additional features, please refer to the release notes. It's 
worth noting that future versions within the 2024.00-xy service packs will introduce new 
features not covered in this overview document. 

For comprehensive instructions on utilizing the new functionality, you can consult the 
Vistro 2024 online help and refer to the document titled "PTVVistro2024_Manual.pdf" 

Release Highlight Summary 
PTV Vistro 2024 brings numerous enhancements that enhance your flexibility in data 
integration and offer new key performance indicators (KPIs) for comprehensive junction 
analysis. We have streamlined the process of integrating field data into your traffic 
models, making it easier and more efficient. 

One of PTV Vistro's standout features is its ability to directly import crucial data from 
traffic controller software such as Econolite Centracs and various commercial monitoring 
and traffic count providers. This includes traffic signal base timing, pattern data, and 
peak-hour turn movement count volume data. This direct connection enables us to 
quickly calculate the environmental impact of carbon emissions and measure the 
emissions reductions achieved through the adoption of electric and autonomous 
vehicles. 

In an era characterized by transformative automotive technologies, it becomes essential 
to align our design and policy decisions with modeling tools and KPIs that match our 
evolving objectives. With the rise of connected and autonomous vehicles (CAVs) and the 
growing prevalence of electric vehicles (EVs), we must adapt to the dynamics of modern 
vehicle fleets. The critical question is: How can we define a "good design" within this 
ever-evolving landscape? Vistro can provide the answer! 

Vistro 2024 tackles this challenge by incorporating attributes that are relevant to CAVs 
and EVs, enabling you to make informed decisions regarding signal optimizations that 
extend beyond mere capacity enhancements. 

Moreover, PTV Vistro now offers enhanced integration capabilities, allowing your 
engineering design details to effortlessly create and maintain Visum and Vissim models. 
You can seamlessly transfer sections of your Vistro models to update your Visum 
planning model or use Vistro for rapid studies on leading pedestrian intervals, 
seamlessly incorporating them into a full Vissim microsimulation. 

With PTV Vistro 2024, you gain access to a suite of advanced features and tools that not 
only simplify data integration and analysis but also empower you to effectively navigate 
the complexities of modern transportation systems.  
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1 Workspace 

1.1 Vistro’s start page website 

Keep yourself informed about the latest Vistro updates by utilizing our new 'Open Start 
Page in Web Browser' option in the 'View' menu. This feature simplifies the process of 
reopening the Vistro start page in your web browser. By using it, you can revisit 
important tutorial materials, stay updated on the latest service pack releases, and access 
detailed information regarding upcoming events. 

This useful addition guarantees that you can effortlessly access the most current and 
pertinent Vistro resources, ensuring you are well-informed and ready to maximize the 
benefits of our software. 
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2 Analysis Methods 

2.1 Emissions 

Vistro's latest emissions calculation feature provides a user-friendly solution for 
evaluating your network's environmental impacts. This innovative tool allows you to 
easily analyze various aspects of your network's ecological footprint, including 
operational fuel consumption, vehicle miles traveled, and emissions of harmful gases like 
carbon dioxide (CO), nitrogen oxides (NOx), and volatile organic compounds (VOC) at 
both the intersection and network levels. This comprehensive approach offers a broader 
set of metrics to optimize your traffic signal management, going beyond addressing 
signal delay. 

You can conveniently find the results of these emissions calculations in a dedicated 
'Emissions' sub-table within the 'Traffic Control' workflow for each intersection. 
Moreover, accessing the total emissions data for your entire network is straightforward 
through the network statistics window. These values seamlessly integrate into Vistro's 
reports, ensuring that you have essential environmental data at your fingertips when 
making informed decisions. 

 

To enhance your experience further, Vistro provides 'Global Settings' that enable you to 
customize emissions values based on your local vehicle fleet composition. Whether you 
prefer imperial or metric units, you can tailor the calculations to match the specific 
characteristics of your region, ensuring accuracy and relevance in your assessment of 
environmental impact. 

With Vistro's advanced emissions calculation feature, you can now make more informed 
and environmentally conscious decisions while managing your network, contributing to 
a greener and more sustainable transportation infrastructure. 

 

 



 Analysis Methods 

© 2023 PTV Planung Transport Verkehr GmbH 7 

 

2.2  Proportion of Electric vehicles 

Vistro now evaluates the impact of electric vehicles on carbon emissions, turning it into a 
valuable tool for exploring different scenarios and promoting local policies and 
electrification goals. Moreover, you can future-proof your designs and fine-tune your 
vehicle fleet further by considering connected and autonomous vehicles at signalized 
intersections and roundabouts using HCM 7th Edition calculations. 

In the 'Volumes' workflow, you can easily integrate the 'Proportion of EV%' parameter at 
signalized intersections to precisely account for electric vehicles in traffic volumes. This 
adjustment efficiently trims down the number of vehicles factored into emissions 
calculations, resulting in reduced fuel consumption and fewer greenhouse gas emissions 
at the intersection. You can establish a consistent EV% for your entire network using 
'Global Settings' and the multi-change tool. 
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3 Traffic Control Workflow 

3.1 Patterns 

Vistro is a unified system that generates multiple time-of-day timing plans. You can select 
and optimize multiple timing patterns within a single signal controller. Each pattern 
includes various values for each signal group, with the most important ones being the 
signal phase split, cycle length, and offset. When you designate a pattern as active using 
the newly introduced 'Active Pattern' control in the 'Traffic Control' workflow's 
'Intersection Settings' sub-table, the splits are adjusted, and calculations are performed 
based on the newly activated pattern. 

To access this functionality, simply click the button to open the new 'Patterns' dialog. 
This dialog allows you to add, update, manage, and remove patterns, providing you with 
greater control and flexibility in your signal timing plans. 

 

When you import UTDF/Centracs Timing Plans files, the Active Pattern control and the 
Patterns dialog will display the timing plans as selectable patterns. 
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All other patterns are exported to Vissim and Visum for further analysis and setup of 
multiple-pattern simulations. 

 

3.2 Centracs Import/Export 

The integration of Vistro and Centracs creates a seamless system that rapidly 
synchronizes field timing plans and new timing scenarios. This integration simplifies the 
process of importing Centracs signal timings, including multiple patterns, directly into 
Vistro for quick setup and analysis. It eliminates the need for time-consuming 
configurations and fragmented assessments. In Vistro, you can analyze and send all 
newly optimized timing patterns back to Centracs for immediate field deployment, 
ensuring that your traffic signal data stays up to date in your management and modeling 
software. This empowers you to make informed decisions with the latest information. 

With this connection, there's no need for manual entry of signal timing parameters and 
schedules. The Centracs-Vistro integration effortlessly provides a wide range of traffic 
signal time-of-day patterns and timings, ensuring top-notch traffic management. 
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In the 'File > Import' menu, you now have a new option labeled 'Centracs' for importing 
phasing and timing data, which includes splits, cycle lengths, and offsets, from Econolite 
Centracs. Users can specify their preferences for importing files and intersection data. 

Exporting signal timing plans from Vistro to Centracs is equally straightforward, 
accessible through 'File > Export.' Users have the flexibility to choose which 
intersections' data should be exported and whether to export all patterns or only the 
active one. Each intersection's data is organized into individual files within a selectable 
destination folder, with filenames containing the intersection names for easy 
identification. 

 

3.3 Automatic adjustments to Maximum Green 

In Vistro, if you change values like split, amber, all-red, or delayed vehicle green times, 
the software automatically ensures data consistency when exporting to Vissim for 
microsimulation. More precisely, Vistro automatically modifies the Maximum Green time 
to maintain data coherence. 

However, when you use the 'Create Default Signalization' feature, Maximum Green time 
will now synchronize only with the splits defined in Pattern 1. This adjustment won't 
apply to other patterns. Users can manually enter a specific value to override this 
calculation if necessary. 

3.4 Phasing & Timing Basic and Active Pattern sub-tables 

We reorganized the Traffic Control workflow in Vistro to enhance the correlation of RBC 
signal parameters with Vissim. Specifically, we updated the order of rows for HCM 
analysis types. Additionally, we divided the sub-table 'Phasing & Timing' into two distinct 
sub-tables: 'Phasing & Timing (Basic)' and 'Phasing & Timing ("Active Pattern")'. 

The 'Phasing & Timing ("Active Pattern")' sub-table now encompasses the values 
associated with the currently selected pattern, while the 'Phasing & Timing (Basic)' sub-
table contains values that remain consistent across all patterns. The 'Active Pattern' sub-
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table holds pattern-specific values or values related to the Free Running timing. It's 
important to note that the Vistro reports also reflect these adjustments. 
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4 Trip Generation Workflow 

4.1 Internal capture 

Vistro has now integrated a user-friendly feature for adjusting generated trip data to 
consider internal trips. You can use the ITE trip generation API to import results, apply a 
simple internal capture rate (or any trip reduction factor), and obtain adjusted trip values 
without the need for external spreadsheet calculations. 

In the Trip Generation workflow grid, Vistro includes a new column labeled '% Internal 
Capture.' This column empowers you to specify the percentage by which Zone trips, 
whether entered manually or retrieved from the ITE Trip Gen web application, can be 
reduced to account for internal trips. Moreover, three additional columns — 'Trips 
Generated Adjusted,' 'Trips In Adjusted,' and 'Trips Out Adjusted' — clearly demonstrate 
how this internal capture rate impacts overall demand. These adjusted trip values 
seamlessly integrate into the 'Trip Distribution' and 'Trip Assignment' workflows, 
ensuring a consistent data flow. 

Furthermore, the generated report includes these adjusted values, serving as a valuable 
reference point for validating the accuracy of your trip generation data. This 
comprehensive approach streamlines the adjustment process and bolsters the reliability 
of your transportation planning and analysis tasks. 

 

4.2 ITE Trip Generation Statistics 

Vistro's ITE TripGen API interface provides data statistics that inform you about the 
number of studies, standard deviation, and reliability of the ITE trip generation study 
data. This view summarizes the unique parameters and fitted-curve equation of the 
query for your review and includes links to the official ITE data plots. 
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5 Graphical Editors 

5.1 Roundabouts 

In Vistro 2024, you can take advantage of improved roundabout visualization to achieve 
precise design and receive feedback. You have the capability to create ideal radii, 
splitter islands, and circular lanes. What sets Vistro apart is its unique feature that enables 
you to import and simulate your roundabout directly in Vissim, a top-tier simulation tool. 
This means that your design specifics, such as bypass lanes, turn lanes, and radii, are 
represented in both Vissim and Visum, simplifying the assessment of corridor mobility at 
various levels of detail. 

 

5.2 Network visualization improvements 

We have enhanced the visualization of dedicated lanes, specifically channelized or 
bypass lanes that do not extend to the stop line. Now, we measure the length of these 
lanes from the point where the movement begins to separate from the main approach. 
In previous versions, this measurement commenced at the stop line. This updated 
visualization aligns more closely with the resulting Vissim network after an export. 

We've also made improvements in the display of channelized turns with dedicated target 
lanes. The movement now seamlessly connects to the target lane, providing a smoother 
representation. Target lanes using channelized turn, now are visualized with a lane 
continuing further downstream. 
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6 Export 

6.1 Leading Pedestrian Intervals in Vissim 

Vistro now exports Leading Pedestrian Intervals (LPI) to Vissim 2024 via ANM and to the 
Vissim Preview. Vistro's unique built-in functionality eliminates the need for false phases. 
Quickly create and correctly model your LPIs and optimize entire networks. Simulate LPIs 
directly in Vissim with push-button detection. These features make investigating LPIs in 
your next study intuitive and cost-effective. 

'Delayed Vehicle Green' directly exports to Vissim's new LPI value. In previous versions of 
Vistro, we used to create overlaps in the PRBC file and write the value to the 'Delay Green' 
field of the overlap. Now, Vistro will now directly import the 'Delayed Vehicle Green' value 
into the 'Delay Green (LPI)' field in the Basic Timing table in Vissim, and there will be no 
creation of overlaps. 

 

 



 Export 

© 2023 PTV Planung Transport Verkehr GmbH 16 

 

6.2 Vistro Merge & Update tool in Visum 2024 

PTV Vistro, a leading traffic engineering tool, prioritizes user-friendly interfaces and 
efficient junction coding. In PTV Visum 2024, a new tool seamlessly combines junction 
and signal data from Vistro's merge file. You can insert multiple Vistro networks into a 
regional transportation model to initiate new projects or incorporate updates. This 
improvement simplifies the process of integrating local Vistro junction details into 
regional models, eliminating redundant coding and optimizing data utilization. 

This functionality empowers engineers to concentrate on dedicated traffic analysis using 
Vistro, while planners focus on PTV Visum. PTV Vistro serves as a bridge between your 
agency's traffic operations and planning departments. Moreover, it stands out as the 
premier traffic signal optimization software, ensuring your advanced simulation tools 
remain well-prepared for upcoming challenges. 
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6.3 Better Vissim export of signals 

We made several improvements to enhance Vissim exports and ensure consistent 
coordination settings for controllers in Vistro. Vistro now takes the initiative to identify 
startup signal groups automatically, eliminating potential warnings in Vissim. In the case 
of coordinated controllers lacking coordinated flags on signal groups, Vistro now 
generates these flags automatically. Additionally, the ICA check now highlights any 
disparities between the controller settings and the coordinated flags of the signal 
groups. Conversely, isolated controllers operating in fully actuated mode, consist of a 
cycle length of zero in the export. 
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